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CFA Institute Research Challenge 
Hong Kong Local Final 2018-19 

 
 
INTRODUCTION  
 
The Hong Kong local final CFA Institute Research Challenge hosted by The Hong Kong Society of Financial 
Analysts is a competition between university-sponsored teams that research a designated publicly traded 
company, prepare a written report on that selected company and then present their findings to a panel of judges.  
The competition has three levels: Local, Regional, and Global.  Winners at the Local level advance to compete 
against Teams within their geographic region at the Regional level.  Winning Teams at the Regional level 
advance to compete at the Global level.  One team is designated the ultimate winning team, or Champion, at the 
Global level.  No purchase is necessary in order to participate. 
 
1. GENERAL PROVISIONS 
 
1.1  Conflicts of Interest  
 
All participants in the CFA Institute Research Challenge, including hosts, teams, team members, industry mentors, 
faculty advisers, judges, and graders have an obligation to avoid actual or potential conflicts of interest with their 
participation. A conflict of interest is any matter that could reasonably be expected to impair an individual’s 
independence and objectivity or interfere with an individual’s duties. A conflict may be actual or perceived. 
As an example, a conflict of interest may exist when a participant or a participant’s family member or close 
friend is involved in activities that affect the participant’s ability to perform his or her role fairly and 
impartially, but conflicts of interest can arise even without a personal relationship. For instance, hosts, mentors, 
and advisers also have an obligation to avoid purposefully or inadvertently pressuring teams to make a particular 
investment recommendation.  
 
To avoid any actual or perceived conflicts of interest, each participant must disclose to CFA Institute in writing any 
potential conflicts, including but not limited to any ownership interest in the subject company and any close 
personal or professional relationships with employees at the subject company. Judges and graders must further 
disclose any close personal or professional relationship with team members, mentors, or faculty advisers.   
Potential conflicts of interest must be disclosed promptly upon becoming aware of the potential conflict. 
 
CFA Institute (with assistance as necessary from the local level host) will investigate any disclosures of actual or 
potential conflicts of interest. If a conflict of interest is found to exist and cannot be reasonably and timely cured, 
the individual with the conflict of interest will be disqualified from participation. If CFA Institute determines that it is 
necessary to protect the integrity of the competition, CFA Institute may disqualify a team from the competition if 
any team member, industry mentor, or faculty advisor is found to have a conflict of interest that is incapable of 
being reasonably and timely cured. In extraordinary circumstances where a local level host is found to have a 
conflict of interest, CFA Institute may, in its discretion, disqualify the local level host and all teams from that 
location from participation in the CFA Institute Research Challenge. The decision of CFA Institute regarding the 
existence of a conflict of interest and its determination regarding the disqualification of any individual or team are 
final and binding.  

 
1.2  Plagiarism  
 
Plagiarism is defined as copying or using in substantially the same form materials prepared by others without 
acknowledging the source of the material or identifying the author and publisher of such material. Teams can read 
existing research on the subject company, but all analysis should be their own; they may not copy analysis (i.e., 
plagiarize) from another source.  
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Teams also must not:  
 

a. use excerpts from articles or reports prepared by others either verbatim or with only slight changes in 
wording without acknowledgment,  
b. cite specific quotations as attributable to “leading analysts” and “investment experts” without 
naming the specific references,  
c. present statistical estimates of forecasts prepared by others and identifying the sources but without 
including the qualifying statements or caveats that may have been used,  
d. use charts and graphs without stating their sources, or  
e. copy proprietary computerized spreadsheets or algorithms without seeking the cooperation or 
authorization of their creators.  

 
The prohibition on plagiarism applies both to a team’s written report and its presentation.  
 
Sourced information should be properly cited using a generally accepted citation system. Generally accepted 
citation systems include, but are not limited to, the Chicago Manual of Style, the Harvard referencing system, and 
MLA (Modern Language Association) style.  
 
Allegations of plagiarism will be investigated by the local host (at a local level competition) or by CFA Institute (at 
the regional or global competition). Teams found guilty of plagiarism will be disqualified and reported to the CFA 
Institute Professional Conduct Program. The team’s university may also be ineligible to participate in the 
following year’s competition. The decision of local host or CFA Institute (as applicable) regarding plagiarism is 
final and binding.  
 
1.3  Third Party Intellectual Property Rights  
 
Related to the concept of plagiarism, respect of third party intellectual property rights is essential to the CFA 
Institute Research Challenge. While teams are free to include text, images, graphics, or other logos in their written 
reports and presentations as permitted by these rules, it is the obligation of each team to ensure that the use of 
any third party materials complies with all applicable copyright and trademark laws. Third party images included 
in any written report or presentation must be appropriately licensed from the images’ owners. Where 
legally necessary, teams should secure the permission of the owners of any trademarks or service marks 
incorporated into their written report or presentation. CFA Institute encourages each local host to work with the 
subject company it selects to provide its local teams with the necessary permissions to use the local host’s 
trademarks or other intellectual property in their CFA Institute Research Challenge written reports and 
presentations. By participating in any level of the CFA Institute Research Challenge, each team represents and 
warrants that neither its written report nor its presentation infringes or violates the copyright, trademark, trade 
secret or other intellectual property right of any third party anywhere in the world.  
 
By participating in the CFA Institute Research Challenge, CFA Institute grants each participating team a non-
exclusive, non-transferable, revocable license to use the CFA Institute name and logo as specified in Appendix B 
to these Rules for the limited and specific purpose of that team’s participation in the CFA Institute 
Research Challenge. Teams will use those materials only as specified in Appendix B and these Rules. No other 
use of CFA Institute’s intellectual property is permitted. Teams may not change or alter the CFA Institute 
name or logo in any way.  

 
1.4  Use of Reports  
 
CFA Institute shall own the copyright in all materials prepared by or for hosts, teams, industry mentors, 
graders, judges, or faculty advisers in connection with the CFA Institute Research Challenge. The written 
reports and presentations prepared for the challenge may not be used for any purpose other than participation in 
the CFA Institute Research Challenge.  
 
1.5  Participant Information  
 
By participating in the CFA Institute Research Challenge, each participant acknowledges that CFA 
Institute collects, processes, and shares personal information of participants in the CFA Institute 
Research Challenges described in the CFA Institute Privacy Policy. Each participant agrees that CFA 
Institute and its affiliates (including the local host), shall have the right to use such individual’s name, 
voice, photograph, likeness, their appearance in any medium or forum anywhere in the world (including 
online) without further compensation, unless prohibited by law.  

https://www.cfainstitute.org/about/governance/policies/Pages/cfa_institute_privacy_policy.aspx
https://www.cfainstitute.org/about/governance/policies/Pages/cfa_institute_privacy_policy.aspx
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B.  OFFICIAL RULES – HONG KONG LOCAL FINAL 
 
2. TEAMS  
 
2.1 Team Composition 
 
a) Only one team may represent a university1. 
b) Each university is responsible to assemble a team to represent it in the Challenge by the appointed deadline. 
c) Teams may consist of no fewer than 32 and no more than 5 students enrolled in the current term at the 

university that they represent. 
d) Each university team must consist of undergraduate, graduate, or a combination of undergraduate and 

graduate students. 
e) There can be no alternates.  If a team loses one of its members, that member can be replaced no later than 

two weeks prior to the submission of the Written Report at the Local level.  If a team falls below 3 registered 
members after this date, they may not be eligible to continue in the competition. 

 
2.2  Team Member Requirments 
 
Each Team Member must: 
a) accept the terms of CFA Institute’s Participation Agreement upon registration; 
b) agree to abide by the CFA Institute Code of Ethics and Standards of Professional Conduct; 
c) be a currently enrolled university student in an undergraduate or graduate program at the time of the Local 

level Opening Ceremony; 
d) be registered for at least a part-time course load, as defined by his or her university, at the time of the local 

level Opening Ceremony;  
e) confirm your participation by returning the Registration Form to HKSFA on or before Thursday, 18th 

October 2018.  Names of participants can be submitted later by Wednesday, 24th October 2018; 
f) complete the official registration form on the CFA Institute Research Challenge website no later than 

Friday, 9th November 2018 (within 2 weeks of kickoff meeting).  Timely completion of the official 
registration entitles students to be recognized participants by CFA Institute and ensures that winning team 
members are eligible to travel to regional and/or global levels.  Replacement students must register within one 
week from the start of their participation; 

g) If the team member has graduated at the time of the local, regional, or global final, the team member may still 
participate in the competition.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

__________________________________________________________________________________________   
1A university is defined as a degree-granting institution that primarily delivers teaching to students in a traditional educational setting, such as a 
classroom, as opposed to primarily through electronic media. This includes universities that provide online learning in addition to their 
classroom-based course offerings. The institution should hold educational accreditation by an accrediting agency recognized by mainstream 
academia to operate as an accreditor or authorization by a government organization, whichever is the standard for the country where the 
institution is located. CFA Institute may, at its sole discretion, grant exceptions to this rule on a case-by-case basis.   
 
2If, because of extenuating circumstances, such as travel visa denial or serious illness/injury, less than three members of a team are able to 
attend one of the in-person events (local, regional, or global), that team will not be disqualified provided that there are still at least three official 
members on the team. If a team member is formally dismissed from or voluntarily quits the team, and the remaining team comprises less than 
three members, that team will no longer be eligible to participate in the competition.   
 
Fundamental company analysis is defined as the examination of publicly available information and the formulation of forecasts to estimate 
the intrinsic value of an equity security. Examples include estimating an equity security’s value using company data, such as earnings and 
sales forecasts, and risk estimates as well as industry and economic data, such as economic growth, inflation, and interest rates. 
  

https://www.cfainstitute.org/ethics/codes/about-code-of-ethics-and-standards
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2.3 Team Member Ineligibility 

 
An individual is ineligible to be a Team Member, if that individual: 
a) has previously participated as a team member at any level of the CFA Institute Research Challenge 

on any team that has submitted a Written Report at the Local level; 
b) has been, or is, employed3 in a role within the core investment management profession. Core investment 

management professionals are those individuals primarily involved in activities related to the investment 

decision-making process — generally portfolio managers, financial advisors, and research analysts on both 

the buy and sell side. The core investment management industry is comprised of firms (or larger firm business 

lines) primarily engaged in asset management (mutual funds, hedge funds, private equity, real estate 

investment, investment research and ratings, and investment advisory services), wealth management, 

fiduciary asset ownership (such as pension funds, endowments, and sovereign wealth funds), and their 

related regulators and standard setters. If an individual’s work was solely an internship,4 he or she is 

permitted to participate as a team member;  

c) has been, or is, a CFA® charterholder;  
d) is employed by CFA Institute, the subject company, or the local host;  
e) is under investigation or has been sanctioned by the CFA Institute Professional Conduct Program; or  

f) has ever been convicted of a felony or crime punishable by more than one year’s imprisonment or has ever 
engaged in conduct which would violate the CFA Institute Code of Ethics and Standards of Professional 
Conduct.  

 

2.4  Research 
 
Only Team Members may conduct research on the Subject Company for the purposes of the CFA Institute 
Research Challenge.  Teams may use only publicly available information in conducting their research.5 
 

a) Teams may utilize their Industry Mentor and/or Faculty Adviser as resources, but may not enlist the help 
of any other individual who has ever been employed as an investment management professional in 
conducting research. 

b) The Written Reports and Presentations should be prepared from the perspective of an independent 
research analyst. 

c) Teams can read existing research on the Subject Company, but all analysis should be their own; they 
may not copy analysis (i.e., plagiarize) from another source into their Written Reports or Presentations. 
Sourced information should be properly cited using a generally accepted citation system. 

 
 
 
 
 
 
 
 
__________________________________________________________________________________________ 
3For purposes of these rules “employed” also includes performing services as an independent contractor, consultant, “freelancer,” or other 
similar service as well as formal employment as an employee. 
 
4CFA Institute defines an internship as real-world work experiences in which students fulfill short-term positions within a company  or 
organization in order to gain hands-on experience and develop career-specific skills. Internships may be paid or unpaid, with or  without 
academic credit, and are of varying lengths. 

 
CFA Institute defines an internship as real-world work experiences in which students fulfill short-term positions within a company or 
organization in order to gain hands-on experience and develop career-specific skills. Internships may be paid or un-paid, with or without 
academic credit, and are of varying lengths. 
 
5Publicly available information includes: 
1) Information in company financial statements, press releases 
2) Information in the media about the company and its competitors, and 
3) Information produced by data aggregators for general use (e.g., Bloomberg, S&P Global, FactSet, etc.) 
 
Publicly available information does not include: 
1) Information about the company that is (or should be) known only to staff or some staff employed by the company or firms with whom the 

company does business, and 
2) Information that is (or should be) known only to those involved in legal or regulatory proceedings involved with the company. 

 
  

https://www.cfainstitute.org/ethics/codes/about-code-of-ethics-and-standards
https://www.cfainstitute.org/ethics/codes/about-code-of-ethics-and-standards
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2.5 Interaction with Subject Company  
 

Teams may not have contact with subject company corporate executives for the purposes of the CFA Institute 
Research Challenge other than during the informational session (described in the following text) and the one 
permitted follow-up communication.  
 
a) The subject company may provide teams with an informational session. The informational session may 

include a question and answer (Q&A) session during which time teams may pose questions to the subject 
company and the subject company may respond.  

b) Teams may have one follow-up communication with the subject company prior to the local final. This follow-
up communication must be organized by the local host and the contact must be confined to those corporate 
officers who normally interact with investors, such as investor relations officers, CEOs, or chief financial 
officers.  

c) Teams may not have contact with subject company corporate executives or board members for the purposes 
of the CFA Institute Research Challenge other than during the informational session, the Q&A session, and 
the one permitted follow-up communication.  

d) Teams are permitted to interact with the company as a member of the general public (e.g., teams may dine in 
a restaurant that is a subject company or take a tour of the subject company if it is publicly available).  

e) Teams may contact the subject company’s customers, competitors, former employees, and suppliers in 
conducting research, including surveys. Contacted individuals should not be known to have ever been 
employed as an investment management professional. Each team member must identify him/herself as a 
student and disclose his/her participation in the CFA Institute Research Challenge.  

f) Prior to contacting the subject company, its customers, competitors, former employees, or suppliers, the team 
must submit its questions to the faculty adviser or industry mentor. The faculty adviser or industry mentor 
must participate in each communication but only for the purpose of ensuring that no material nonpublic 
information is discussed. Faculty advisers and industry mentors are not permitted to ask any questions or 
provide any opinions on the subject company. The time spent by the faculty adviser or industry mentor while 
monitoring this kind of communication will not count toward the maximum number of hours allotted for faculty 
adviser or industry mentor involvement.  
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2.6  Written Reports 
 
Each Team must prepare a written research report on the Subject Company.  Teams may utilize their Industry 
Mentor or Faculty Adviser as resources, but may not enlist the help of any other investment management 
professionals in writing the content of the report. 
 
The Written Report must: 
 
a) conform to the guidelines set forth in Attachment A, “Written Report Guidelines;” the cover pages are 

shown in Attachment B; 
b) not exceed 10 A4-sized pages, but may include an appendix no longer than 20 A4-sized pages; 
c) be written in the English Language; 
d) contain only publicly available information; 
e) be the original work of the Team Members; 
f) be properly cited using a generally accepted citation system. 
g) be prepared from the perspective of an independent research analyst; and 
h) be submitted to the local level host (i.e. HKSFA) by the deadline, i.e. before 4:00p.m. on 10th January 

2019 (Thursday) by email to hksfa_rc@yahoo.com.hk. 
i) The Written Report will be graded according to the criteria set forth in Attachment D, the Research Report 

Evaluation Form. 
 
 
*The 5 teams with the highest Written Report scores will advance to give a presentation to a panel of 
judges.  Other teams will be invited to attend the Local Final on 23rd February 2019 (Saturday). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
__________________________________________________________________________________________ 
 
Volunteer charterholders who mentor or advise students must request and receive permission from their firm to share reports prepared either 
within their firm or from outside sources. Additionally, all volunteers who work with students should ensure that they understand how to avoid 
plagiarism and what is required when citing the work of another research analyst. 
 
Generally accepted citation systems include, but are not limited to, The Chicago Manual of Style, the Harvard referencing system, and the 
MLA Style. 
 
Instructions on how to change the paper size in Microsoft Word are available in Attachment C. 
Hosts may impose penalties for late submissions.  Penalties may include, but are not limited to, point deductions or disqualification from the 
competition.  The decision to impose penalties and the extent of those penalties is at the discretion of the host. 

  

mailto:hksfa_rc@yahoo.com.hk
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2.7  Presentations  
 
The 5 teams with highest score will make a Presentation of their findings to a panel of Judges. 
 
a) Teams may utilize their industry mentor and/or faculty advisor as a resource for guidance, direction, 

suggestions, and feedback. Teams may not enlist the help of any other person who has ever been employed 
as an investment management professional or finance faculty member in preparing content or evaluating the 
presentation (including, but not limited to, mock judging panels).    

b) The students may not hand the Judges any printed materials before/after the Presentations, but the 
Local Host will print out or prepare soft copies of the Presentation slides for each team and distribute to the 
Judges before the event. 

c) Teams may not use props* in their Presentation. 
d) Only Team Members may participate in the Presentation. 
e) The Presentation is limited to 10 minutes; however, an additional 10 minutes will be provided 

to answer questions posed by the Judges. Only Judges are permitted to pose questions to a Team 
during the question-and-answer portion of a Presentation. 

f) Each Presentation will be timed and the Timekeeper will provide a one minute warning and an 
announcement when time has expired.  When the Timekeeper announces that time has expired, Teams 
must immediately conclude the Presentation. 

g) Presentations will be judged according to Attachment E, the “Presentation Scoring Sheet”. 
h) The softcopies of the Powerpoint slides are due to HKSFA staff no later than 1:00pm on Thursday, 

21st February 2019. 
i) The Local Final and Award Ceremony will be held on Saturday, 23rd February 2019. 

 
 

3. FACULTY ADVISERS, INDUSTRY MENTORS, JUDGES AND GRADERS 
 

3.1  Faculty Advisers 
 

a) Each Team will be provided one Faculty Adviser.  The Faculty Adviser must be currently employed as a 
faculty member by the Team’s sponsoring University. 

b) The Faculty Adviser will be selected by the Team’s University. 
c) The Faculty Adviser must agree to abide by the CFA Institute Code of Ethics and Standards of Professional 

Conduct.  
d) The Faculty Adviser’s primary responsibility is to provide guidance and direction to the Team throughout all 

levels of competition. 
e) The Faculty Adviser may not conduct any analysis for the team’s written report or presentation. 
f) The Faculty Adviser may not contribute any research or content to either the Written Report or the 

Presentation other than by providing guidance, direction, suggestions, and feedback. 
 

3.2  Time Permitted with Faculty Advisers 
 

Teams are permitted to use a faculty adviser on substantive matters for limited hours. Teams may spend up to 10 
hours with the faculty adviser prior to submitting the written report. For each local, regional, or global final in which 
the team competes, the faculty adviser may contribute an additional three hours. Logistical work, such as 
arranging meeting space and times and class attendance, does not count toward the time limit. Failure to abide 
by these time limits will result in the team’s and the faculty advisor’s disqualification from the CFA 
Institute Research Challenge. 
 

3.3  Industry Mentors 
 

Each Team will be provided one Industry Mentor. 
 

a)   The Industry Mentor will be selected by the local level host. 
b)   The Industry Mentor must agree to abide by the CFA Institute Code of Ethics and Standards of Professional 

Conduct.  
c)   The Industry Mentor may not conduct any analysis for the team’s written report or presentation. 
d) The Industry Mentor may not contribute any research or content to either the Written Report or the  

Presentation other than by providing guidance, direction, suggestions, and feedback. 
e)   Students may not receive assistance from additional finance industry professionals. 
 
__________________________________________________________________________________________ 
*A prop is defined as an object used by students to enhance or illustrate an aspect of the team presentation. 

 

https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
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3.4  Time Permitted with Industry Mentors 
 

Teams are permitted to use an industry mentor on substantive matters for limited hours. Teams may spend up to 
six hours with the industry mentor prior to submitting the written report. For each local, regional, or global final in 
which the team competes, the industry mentor may contribute an additional two hours. Logistical work, such as 
arranging meeting space and time, does not count toward the time limit. Failure to abide by these time limits 
will result in the team’s and the faculty advisor’s disqualification from the CFA Institute Research 
Challenge. 
 
3.5 Judges 
 
a) Judges will independently evaluate each Presentation using the Presentation Scoring Sheet attached as 

Attachment E. 
b) Judges must agree to abide by the CFA Institute Code of Ethics and Standards of Professional Conduct.  
c) Each Local level competition must have a minimum of three Judges per panel. 
d) The Judges will be selected by the event Host.  All Judges must be investment professionals.  It is 

recommended they have experience writing and reviewing equity research reports. 
 
3.6 Graders 
 
a) Graders will independently evaluate each Written Report using the Research Report Evaluation Form 

attached as Attachment D. 
b) Graders must agree to abide by the CFA Institute Code of Ethics and Standards of Professional Conduct. 
c) Graders will be selected by the event Host. 
d) All Graders must be investment professionals with experience in writing and reviewing research 

reports. 
 

 
 

 

 

 

 

 

 

 

 

  

https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
https://www.cfainstitute.org/ethics/codes/ethics/Pages/index.aspx
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Attachment A – Written Report Guidelines 
 
Each team must prepare a written research report on the subject company chosen by the local host.  Teams may 
use their industry mentor or faculty adviser as resources, but may not enlist the help of any other professionals in 
writing the actual report. 
 
The Written Report must: 
 
• be no longer than ten pages (not including the front and back covers provided by CFA Institute) on A4* sized 

paper (210mm × 297mm, 8.27” × 11.69”), although you may include an appendix no longer than 20 A4-sized 
pages; 

• include the following information in a header on the first page: 
- Company name 
- Exchange 
- Ticker symbol 
- Sector 
- Industry 
- Recommendation (buy/sell/hold) 
- Current price (as of __date) 
- Target price (% increase/decrease) 

• contain only publicly available information; 
• be the original work of the team members; 
• be prepared from the perspective of an independent research analyst; 
• be submitted to the local-level host by the deadline established by the host; 
• include the front and back covers provided by CFA Institute with the information in highlighted text filled in 

(teams must not alter any other part of the cover pages, including the CFA Institute logo); the back cover 
should be placed after the appendix; and 

• contain (but is not limited to**) the following sections: 
- Business Description 
- Industry Overview and Competitive Positioning 
- Investment Summary 
- Valuation 
- Financial Analysis 
- Investment Risks 
- Corporate Governance 

 
*If you would like to print an A4 sized document to Letter sized paper, you can select the option to automatically 
resize the document in your printing options by selecting Page Layout > Page Setup > Print Options > Advanced. 
Ensure that “Scale content for A4 or 8.5 x 11” paper sizes” is selected: 
 

 
 
**You may also include other headings that cover important information not otherwise covered in the previously 
listed sections. 
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Attachment B – Written Report Cover with Disclosure 

  

 

 

 
CFA Institute Research Challenge 

 
hosted by 

 

  
 
 

University Name 
 

 

 
The CFA Institute Research Challenge is a global competition that tests the equity research and 
valuation, investment report writing, and presentation skills of university students. The following report 
was submitted by a team of university students as part of this annual educational initiative and should 
not be considered a professional report.  

 
 
Disclosures:  
Ownership and material conflicts of interest  
The author(s), or a member of their household, of this report [holds/does not hold] a financial interest in the securities of this 
company.  
The author(s), or a member of their household, of this report [knows/does not know] of the existence of any conflicts of interest 
that might bias the content or publication of this report. [The conflict of interest is…]  
Receipt of compensation  
Compensation of the author(s) of this report is not based on investment banking revenue.  
Position as an officer or a director  
The author(s), or a member of their household, does not serve as an officer, director, or advisory board member of the subject 
company.  
Market making  
The author(s) does not act as a market maker in the subject company’s securities.  
Disclaimer  
The information set forth herein has been obtained or derived from sources generally available to the public and believed by 
the author(s) to be reliable, but the author(s) does not make any representation or warranty, express or implied, as to its 
accuracy or completeness. The information is not intended to be used as the basis of any investment decisions by any person 
or entity. This information does not constitute investment advice, nor is it an offer or a solicitation of an offer to buy or sell any 
security. This report should not be considered to be a recommendation by any individual affiliated with [society name], CFA 
Institute, or the CFA Institute Research Challenge with regard to this company’s stock. 
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Attachment C – How to Change Paper Size to A4 

 
For Microsoft Word 2007/2010/2013: 
 

➢ Open Microsoft Word. 
➢ Click on the “Page Layout” ribbon. 
➢ Click “Size.” 
➢ Scroll until you find “A4.” 
➢ Select A4. 
➢ Watch a step-by-step video here. 

 

For Microsoft Word 2003: 
 
➢ On the File menu, click Page Setup, and then click the Paper tab. 
➢ Select A4. 
➢ See the Microsoft website for more information. 
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Attachment D – Research Report Evaluation Form 

 

CFA Institute Research Challenge 

Hong Kong Local Final 2018-19 
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Attachment E – Presentation Scoring Sheet 

 

CFA Institute Research Challenge 

Hong Kong Local Final 2018-19 
 

Presentation Scoring Sheet 

 

 

 

 


